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AOP System Development -- Agenda

 What is Aspect-Oriented Programming?
* High level system requirements.
e (Can Object-Oriented systems be improved upon?

e How do we know what has been done and/or is
happening in our system?

e Does it work? Is it extensible, maintainable, etc.?
e What's left?

 Wrap up — meet me for a beer (or two) at the
reception...
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What is Aspect-Oriented Programming?

e “In software engineering, the programming
paradigms of aspect-oriented programming
(AOP), and aspect-oriented software
development (AOSD) attempt to aid programmers
in the separation of concerns, specifically cross-
cutting concerns, as an advance In
modularization. AOP does so using primarily
language changes, while AOSD uses a
combination of language, environment, and
method.” -- wikipedia.org
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What is a cross-cutting concern?

* “In computer science, cross-cutting concerns, or
crosscutting concerns, are aspects of a program
which affect (crosscut) other concerns. These
concerns often cannot be cleanly
decomposed from the rest of the system in
both the design and implementation, and result
in either scattering or tangling of the program, or
both.” -- wikipedia.org
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System Requirements

 Technology conference

e Conference has participants
* Name
 Email
e Conference has speakers
e Summary
« Speakers have sessions
» Title
» Abstract

e Store information for subsequent use
e Some kind of User Interface
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System Architecture

e Java will be used to develop the domain model.

* Business Logic
e Security

* Logging
e Transactions
 Persistence

e Performance

A database will be used to store the information.
e A browser will be used for the User Interface.

Yawn... “you're telling me this is emerging?”
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Can Obiject-Oriented systems be improved?

e After analyzing the system's requirements, we've
got several cross-cutting concerns.

* “Aspectual decomposition” to the rescue.

* Architecture — emerging:

* In order to address inherent OO req't. to implementation
redundancy (tangling/scattering), Aspectd will also be used to
develop the domain model.

* Objects and Relational databases require mapping... We need to
get this app into production “yesterday”. In order to expedite
delivery (with a nice side effect of better performance), the
relational DB and ORM will be replaced with an Object DataBase
(DB40O).

e Continuing with our lazy, er, | mean emerging approach, Stripes
will be used as the MVC framework.
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System Aspectual Decomposition

 Can AOP wire together an entire application so
that its components retain their (clearly)

visible/understandable role(s)?
* Inan MVC, procuring and providing the “M” is an aspect. Can this
be done in an elegant manner?

* In a system with persistence capability, persistence of the domain
without the objects' knowledge (aka, transparent) is an aspect.
Can this be done in an elegant, non-intrusive, timely manner?
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Stripes — a lazy, er, emerging web framework.

e Takes advantage of naming conventions,
annotations, and various reflection mechanisms.

e QOut-of-box wiring of urls to views (in an

ActionBean):

e package naming: web, stripes, www, and action

* ActionBean impls: removes “Action” or “Bean” or “ActionBean”
e converts above info into a path and appends “.action”
 @UrIBinding annotation may be used

* Very powerful binding and validation capability!
* Very nice out-of-box JSP tags.
 @HandlesEvent and reflection handling discovery
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Db4o — can this be real? An object database?

 “Embed db4o's native Java and .NET open
source object database engine into your product
and store even the most complex structures with
only one line of code.” -- db4o.com

 Open source and free under the GPL

RDBMS dbdo
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e Can Object-Oriented Programming be improved
upon?

e How do we know what has been done and/or
is happening in our system?

e Does it work? Is it extensible, maintainable, etc.?
e What's left?

 Wrap up — meet me for a beer (or two) at the
reception...

Emerging Technologies
for the Enterprise



Code scattering and tangling.

e Stripes requires ActionBeans to implement

ActionBean... (at least it's not extension)

e get/setContext
* hold onto ActionBeanContext for subsequent reuse

 For URL mapping, it's either via annotation or

naming, or the fact that the class implements

ActionBean

e does your package structure fall under one of the naming
conventions?

 is your package structure representative of a RESTful url?
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Person POJO screenshot:

person.jsp person-update.jsp n £ logdj.properties 1] MyActic

package domain;

import java.util.List;

_ public class Person {
private String name;
private List<Pet> pets;
private Long 1d;
private transient Longl[] deletelds;

@ public void setDeletelds(Longl] deletelds){this.deletelds = deletelds;}
public Long[] getDeletelds(){return deletelds;}

public void setName(String name]{this.name = name;}
public String getName(){return name;}

public void setId(Long 1d){this.id = 1d;}
public Long getId({){return 1d;}

public void setPets(List<Pet> pets){this.pets = pets;}
public List<Pet> getPets(){return pets;}

¥
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PersonActionBean screenshot:

person.jsp person-update.jsp logdj.properties [J] MyactionBean java |!

l.l-l:lL-l\.-l:IHt.'r LI LT,
#import java.util.List;[]

@lrlBinding (" /Person.action")
public class Person implements ActionBean A
private String name;
private List<=Pet> pets;
private Long 1id;
private transient Longl[] deletelds;
private transient ActionBeanContext context;

~ public ActionBeanContext getContext() {
return context;
1
= 8 public void setContext({ActionBeanContext context) {
this.context = context;
T
= leDef aultHandler

public Resolution view(]{
return new ForwardResolution(" /WEB-IMNF/jsp/person.jsp");

b

=] public void setDeletelds(Longl] deletelds){this.deletelds = deletelds;}
public Longl[] getDeleteIds(){return deleteIds;}

public void setMame(String namel){this.name = name;}
public String getMams(){return name;?}

public void setId(Long 1d){this.id = 1d;}
public Long getTd{){return i1d;}

public void setPetsiList=Pet= petsl){this.pets = pets;}
public List<Pet> getPets(){return pets;}

h
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Aspectual Decomposition: POJO to ActionBean adaptation

* |Implement “ActionBean”

 Keep the passed in ActionBeanContext for
subsequent re-use.

* Provide “event” methods so the class actually
performs something.

 In light of our naming convention not falling under
Stripes' out-of-box qualifiers, provide a
@UrIBinding annotation.
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“Introducing

static crosscutting”

e Artist formerly known as “Introduction” now known
as “Inter-type” (although “introduction” was still
freely tossed around at AOSD '07)

e Provides static enhancements to a class or
classes:

 implement an interface (in this case, ActionBean)
e provide methods (get/setActionBeanContex{(...))
e provide member(s) (private ActionBeanContext abc;)

* Presenter's opinion: “introduction” is still more
easily digestible to newcomers...
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First aspect: StripesActionBeannes

package aop;
import net.sourceforge.stripes.action.ActionBean;

¥ public interface AspectActionBean extends ActionBean {
//convenience interface to asfign Inter-type members and methods

¥

person.jsp person-update jsp logdj.properties [J] Person.java Al

package aop;
import net.sourceforge.stripes.action.ActionBeanContext;

public aspect StripesActionBeanness {

4 private ActionBeanContext AspectActionBean.abc;
- s public ActionBeanContext AspectfActionBean.getContext(){
return this.abc;
I
o < public void AspectActionBean.setContext(ActionBeanContext abc){
this.abc = abc;
I

i
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So we've got some funny new stuff in the gutter...

= person.jsp person-update.jsp logdj.properties [J] MyActionBean.java [J] Persan

&g
= - package aop;

w ([ StripesActionBeanness import net.sourceforge.stripes.action.ActionBeanContext;

Package Ex... Outline &

= %, AspectActionBean.abc . . .
; P public aspect StripesActionBeanness {

+ v declared on =1 private ActionBeanContext AspectActionBean.abc;
@ AspectActionBean . . . .
= public ActionBeanContext AspectActionBean.getActionBeanContext(){
w ¥ AspectActionBean.getActionBeanContext() return this.abc;
+ o declared on }
@ AspectActionBean = public void AspectActionBean.setActionBeanContext(ActionBeanContext abc){
this.abc = abc;

w I AspectActionBean.setActionBeanContext(A }

- o declared on }

@ AspectActionBean

e (utter decorations and AJDT's “Cross
References” view!

 We can see that our inter-type declarations have
been applied to the “AspectActionBean”. So000...

Emerging Technologies
for the Enterprise 405107
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StripesActionBeanness (continued)

e ...what about declaring that a domain object
implements “AspectActionBean™?

Package Explorer Outline | #5 Cross References 2 =0 person.jsp person-update jsp [J] Person.java A i
B & - package aop;
+ @ conference import net.sourceforge.stripes.action.ActlonBeanContext;

- t declarati . . .
2 LLELGESE LGL I e public aspect StripesfctionBeanness {

B declare parents: implements AspectActionBean r declare parents : domain.Conference implements AspectActionBean;
¥, AspectActionBean.abc . . .
< private ActionBeanContext AspectActionBean.abc;
Iy AspectActionBean.getContext()
¥, AspectActionBean setContext(ActionBeanContext) = public ActionBeanContext AspectActlonBean.getContext(){

return this.abc;

}
M S public void AspectActionBean.setContext(ActionBeanContext abc){
this.abc = abc;
I

Emerging Technologies
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StripesActionBeanness (continued)

e ...and what about that @UrlIBinding type
annotation?

public aspect StripesfctionBeanness {
54 declare @type : domain.Conference : @UrlBinding("/Conference.action");

w* o aspect declarations

s declare parents: implements AspectActionBean

Y, AspectActionBean.abc

Ty AspectActionBean.getContext()

Ty AspectActionBean.setContext{ActionBeanContext)
= 5 annotated by

@ stripesActionBeanness.declare @type: domain.Conference | @UrlBinding("/Conference.action")

Emerging Technologies
for the Enterprise 405107
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More Advisement/Declaration Visualization

 AJDT offers the “Aspect Visualization”
perspective.

* Presenter's opinion: this perspective can give you
a good “big picture” view, but beware that aspect

“precedence” isn't necessarily shown as it
executes at runtime!

o .

3| I wrisualiser =2 = B8 | =23 o3 g
“wisualiser - Aspect] Prowvider (fit to wview) -— @ . .
[~ StripesAactionBeannaess

EEtH E] @ |:| StripesBinanyWweawe
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Yet even more Aspect Identification...

 AJDoc: the Aspectd documentation tool

e available via command line tool
e available from within AUJDT

* Presenter's opinion: this tool acts flaky on my Linux machine —
YMMV..

AJBrowser: gui for compiling and navigating
crosscutting structure

Presenter's opinion: | stick w/ AJDT for basically
everything.
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Back to the system....

e So via inter-type declarations, we've made the
Conference class into an ActionBean. This
seems like overkill, doesn't it. Why yes, requiring
every domain object have its own inter-type
AspectActionBean parent is ugly. Fortunately,
Aspectd offers wildcarding for cases like these...

e |n our system, all classes in the “domain”
package should be ActionBeans (if you're thinking
this sounds like an “exposed domain model”,
you're correct). Let's see the enhanced
declaration:

Emerging Technologies
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Accomplishing More with Less: Aspectd's wildcards

e Declaring all classes in the domain package to
Implement AspectActionBean couldn't be easier —

just replace the “domain.Conference” with
“domain.*”!

* This raises the question: “how do | keep track of
advisement deltas?”

 Again, AJDT to the rescue.. let's take a look.
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Monitoring holistic “advisement deltas”

 As you can imagine, the change from
domain.Conference to domain.” is very
significant! The “Crosscutting Comparison” view
can show us what's been changed:

Added
Added
Added
Added
Added
Added
Added
Added

Ll e TR 'Jl 2%

& & & & & & & &

~HB

Problems | Javadoc | Declaration Console &~ Crosscutting Comparison &2

Added/Removed | Source

¥ declare parents: implements AspectActionBean

Y. declare parents: implements AspectActionBean

AspectActionBean.getContext()
AspectActionBean.getContext()
AspectActionBean.setContext{ActionBeanContext)
AspectActionBean.setContext{ActionBeanContext)
AspectActionBean.abc

AspectActionBean.abc

Crosscutting comparison of map00.ajmap with current build (Showing 8 of 16 items)

Relationship

L LB LR L LS A

declared on
declared on
declared on
declared on
declared on
declared on
declared on

declared on

Target

Session
Speaker
Session
Speaker
Session
Speaker

Session

@000

Speaker



Holistic “advisement deltas” (continued)

 AJDT also offers the capability to take
Crosscutting Map “snapshots” of the current
codebase in order to do comparisons. As far as
I'm aware, this is only available through AJDT (no
ANT or Maven). Nevertheless, it's very good info!

e To save a Crosscutting Map, simply right click on

an Aspectd project and follow Aspectd Tools >
Save Crosscutting Map As...
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Back to Stripes..

e During system startup, Stripes introspects
ActionBeans for methods that:
e return a “Resolution”

* have a @DefaultHandler annotation
* have a @HandlesEvent annotation
e At least at this point, our system's “event”

requirements are quite meager — create, read,
and update the domain.

 If you're thinking this looks like another job for

inter-type declarations, you're right! Let's take a
looK..
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ActionBean event handlers via inter-type.

@hefaultHandler

@HandlesEvent (" view")

public Resolution AspectfctionBean.view(]{
return null;

I

@HandlesEvent ("update")

public Resolution AspectActionBean.update(){
return null;

¥

@HandlesEvent ("save")

public Resolution AspectActionBean.save(){
return null;

¥

pointcut aspectActionBeanViewExecution(AspectActionBean bean)
execution(* AspectActionBean+.viewl())
&& this(bean):

pointcut aspectActionBeanUpdateExecution(AspectActionBean bean)
execution(* AspectActionBean+.updatel())
&& this(bean);

pointcut aspectActionBeanSaveExecution(AspectActionBean bean)
execution(* AspectActionBean+.savel())
&& this(bean);

Emerging Technologies
for the Enterprise 04/05/07
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Introducing... the “pointcut”

e “A pointcut is used to select “join points™. It acts
as a filter, matching join point that meet its
specification, and blocking all others.” -- [Colyer —
eclipse AspectJ]

 “Ajoin point is any identifiable execution point in a
system.” -- [Laddad — AspectJ in Action]

* So in the case of the pointcuts in the
StripesActionBeanEventHandling aspect, the
view(), update(), and save() method executions
are the join points. (yes, even methods declared
via inter-type can be used in a pointcut!)

Emerging Technologies
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So now that we've filtered our events via pointcuts...

e “Pointcuts match join points, but advice is the
means by which we specify what to do at those
join points.” -- [Colyer — eclipse AspectJ]

* Aspectd has three kinds of advice:

* before — works before the specified pointcut's join point(s)
» after — works after the specified pointcut's join point(s)

e around — works before and after and sometimes in place of the
specified pointcut's join point(s) --- more on this to come!

e Let's take a look...

Emerging Technologies
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StripesActionBeanEventHandling aspect's advice.

Resolution around(AspectActionBean bean) : aspectActionBeanViewExecution(bean) {
String shortMame = getShorthMame(bean.getClass().getNamel());
String jspFile = new StringBuffer(JSP _DIR).append(shortName).append(".jsp").toString();
return new ForwardResolution(jspFile);

¥

Resolution around(AspectActionBean bean) : aspectActionBeanUpdateExecution(bean) {
String shortMame = getShorthMame(bean.getClass().getNamel());
String jspFile = new StringBuffer(JSP _DIR).append(shortName).append("-update.jsp").toString();
return new ForwardResolution(jspFile);

¥

Resolution around(AspectActionBean bean) : aspectActionBeanSaveExecution(bean) {
dataStore.savelbean);
String shortMame = getShorthMame(bean.getClass().getNamel());
String urlBindingAndId = new StringBuffer("/").append(shortName).append(".action?1d=").append/(k
return new RedirectResolution(urlBindingaAndId);

Emerging Technologies
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A look at our DataStore interface.

 The save() event's execution's advice simply calls
dataStore.save(bean). Let's take a look at the
interface:

package aop;

public interface DataStore {
public <T= T getById(long ID);
public void attach(Object object);
public void save(Object object);
public Long getId(Cbject object);

Emerging Technologies
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DataStore (continued)

And the Db4oDataStore:

public class Db4oDataStore implements DataStore {

private static Db4oDataStore instance;
static {
Chdo.configurel) .objectClass

(). domain.Conference.class) .cascadeOnActivate(true);
Dbdo.configurel) .objectClass

().

().

domain.Conference.class).cascadeOnUpdate(true);
domain.Speaker.class) .cascadeOnActivate(true);
domain.Speaker.class).cascadeOnUpdate(true);

Chdo.configure() .objectClass
Dbdo.configure().objectClass

o T e T e ]

5
private static ExtObjectContainer 08 = Dbdo.openFile("dbdo").ext();

private DbdoDataStore(){}

public static DataStore instance(){
if(instance == null){
instance = new DbdoDataStore(]);

¥

return 1nstance;

¥

public void save(Object object) {
DE.setlobject);

H

e
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But how do the respective aspects get a DataStore?

 To generically “announce” that an aspect (or
class) needs a DataStore, it simply needs to
implement the “NeedsDataStore” interface:

package aop;

public interface MNeedsDataStore {
public abstract void setDataStore(DataStore dataStore);

¥
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DataStore procurement (continued)

e Based on that interface, if you were thinking the
DataStore gets supplied via dependency
Injection, you'd be correct.

* To supply DataStore implementations, we simply
advise “NeedsDataStore” impl (the “+”
construction:

package aop;

public aspect DataStoreProvider {
= pointcut needsDataStoreConstruction(NeedsDataStore nds)
execution(NeedsDataStore+.new(] ]
&% this(nds);

o= after(NeedsDataStore nds) : needsDataStorecConstruction({nds){
nds.setDataStore(DbdoDataStore.1nstancel());
T
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And the actual implementation (w/ IDE cues)..

public aspect DataStoreProvider {
= pointcut needsDataStoreConstruction(NeedsDataStore nds)
execution(NeedsDataStore+.new(])
&& this(nds);

o - after(MeedsDataStore nds) : needsDataStoreConstructioninds){
nds.setDataStore(DbdoDataStore.instance());
+
ks

b  public aspect StripesActionBeanness implements MeedsDataStore {
private DataStore dataStore;

= public void setDataStore(DataStore dataStore)d
this.dataStore = dataStore;
I

¥ 2

Package Explorer Outline &g X

~ o advised by

.  DataStoreProvider.after(NeedsDataStore): needsDataStoreConstruction..

P Y declare parents

EmEIHulg“ T Idlug|ca -
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(Very) Brief introduction to Db4o

Easy to install — just put the respective (Java 5 or
otherwise) .jar in your classpath.

A couple configurations should get you started:

e specify what classes should “cascade on activation”
e specify what classes should “cascade on delete”

ObjectContainer and its more powerful version
ExtObjectContainer are the interfaces you'll use
over 99% of the time.

Db4o cache is by weak reference.

Db4o stores an ID for every object stored —
obtainable via ExtObjectContainer.getlD(object);

Emerging Technologies
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(Very) Brief introduction to Db4o (continued)

e Objects can be retrieved via their Db4o id — this is
an extremely fast way to query. However,
objects retrieved in this manner aren't necessarily
guaranteed to be fully hydrated:
ExtObjectContainer.getByID(long).

 To hydrate objects retrieved via getByID, simply
call ExtObjectContainer.activate(object).

 As you may have guessed, fransient members
are not persisted.

Emerging Technologies
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Back to Stripes..

e SO0 now we can transparently get hydrated
objects, what advantage does this pose?

 We can bind directly into our “exposed domain
model”!

e Stripes examples on the web talk of using hooks
and the framework itself offers a very handy
Interceptor architecture.

 The concept for both, in this case, is the same: if
the request, specifically, the RequestContext,
contains an ID, attempt to retrieve the object,
otherwise, it's an insert (or error).

Emerging Technologies
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Stripes Binding (continued)

* |n the Stripes execution lifecycle, binding always
occurs before event execution.

 Can |l replace “hook” or Interceptor
implementation with an aspect? Absolutely, but
this will entail a new concept - “binary weaving”.

* Binary weaving involves creating pointcuts that
qualify for code in previously existing jars.

e At compile time, the third party jar(s) contents are
examined and where applicable, in essence, the
pointcuts qualify, appropriate advice is “woven”.

Emerging Technologies
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Binary weaving in AJDT

 On a project that has the AspectdJ nature
associated, right click on the project and select
Aspectd Tools > Configure Aspectd Build Path...

* For this system, we need to weave advise into the
Stripes jar — enter its contents into the “Inpath”

tab:

Info

Aspect| Build
Aspect| Compiler
Beaninfo Path

Emerging Technologies

for the Enterprise

=iInpath | =LAspect Path |Qutput jar |

Types added to the in-path are wowven with any aspects present in the project:

% stripes.jar - jhomefaoswald/EmergingTech/stack/stripes/stripes-1.4.2/lib



AJDT binary weaving of the Stripes jar (continued)

* Next, we need to specify where the advised jar
should be written to.

e Presenter's note: | like to make it obvious that a
Jar has been advised by appending ADVISED to
its formal name.

e Specify an applicable location and name in the
“Output jar” tab:

Into

Aspect] Build
Aspect] Compiler
Beanlnfo Path

Builders

Emerging Technologies
for the Enterprise
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Output generated class files to a JAR file instead
of the output directory:

output jar |WebContent/WEB-INF/lib/stripesADVISED jar |




Advice to procure (hydrated) exposed domain objects.

 Easiest way to figure out what needs to be
advised is to get a “"Hello World” app running and
simply set breakpoints.

By doing so, we discover that the method call
“makeNewActionBean(...)" of Stripes'
AnnotatedClassActionResolver class needs an
around advice — remember — if we can't handle
the request (no id/bad id/etc.), we simply delegate
back to Stripes. Let's take a look...

Emerging Technologies
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StripesBinaryAdvisement (ActionBean creation)

,n"l' e

* This pointcut allows us to advise ActionBean creation. The ability of Stripes' binding

* power 1s qulte i1mpressive. Stripes 1s able to bind into as many layers deep of an object

* graph as you may need. Traditionally this 1s done to domain objects that are encapsulated

* 1n a would-be "ActionBean".

:+:.Il."

pointcut makeMewActionBeanExecution(Class clazz, ActionBeanContext context)
execution(ActionBean makeMewhActionBean(Class<? extends ActionBean=, ActionBeanContext))
&& within(AnnotatedClassActionResolver)

&& args(clazz, context);
+ 4

* to return a previously stored, fully hydrated ActionBean object. This functionality

o
L
* This advice determines 1f an "i1d" 1s located in the context and 1f so, attempts
¥
* gnables an "exposed domain model".

+

] :,n'.r
fctionBean around(Class clazz, ActionBeanContext context) : makeMNewActlonBeanExecution(clazz, context) {
ActionBean actionBean = null;

String stringld = context.getRequest().getParameter("1d");

try{
Long 1d = Long.valueOf (stringId);
iflid 1= 0){
actionBean = dataStore.getById(id);//call to datastore
if(clazz.i1sAssignableFrom{actionBean.getClass())){
dataStore.attach({actionBean);//activate the actionBean
}else{
throw new RuntimeException({clazz.getMame()+" 1s not assignable from the retrieved object
¥
I

}catch(NumberFormatException nfe){
actionBean = proceed(clazz, context];
T

return actionBean != null ? actionBean : proceed(clazz, context);



So how can we tell if binary weaving did anything?

 Running the app is an option, but there's got to be
something better, right?

 AJDT to the rescue (again).. Window >
Preferences > Aspectd Compiler -> Information:

Unresclved member in type
Shadow not in structure:

Calculating serial version UID:

M Output weaving info messages to problems view

when binary weaving, this option allows you to see detailed
weaving information,

Emerging Technologies
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Did our binary weave work?

 Yes! The message: Join point method-

execution(net.sourceforge.stripes.action.ActionBean
net.sourceforge.stripes.controller.AnnotatedClassActionResolver. makeNewActionBean(java.la
ng.Class, net.sourceforge.stripes.action.ActionBeanContext))' in Type
'net.sourceforge.stripes.controller. AnnotatedClassActionResolver'
(AnnotatedClassActionResolver.java:361) advised by around advice from

‘aop.StripesBinaryAdvisement' (StripesBinaryAdvisement.aj:65) Ap pea I'S | N th e
“Problems” view:

I R L o R L R LR R

T I R Y L e R e R T T

i Join point 'method-execution{net.sourceforge .stripes.action.ActionBean net.sourceforge stripes.controller.Annotateds

| | v r ' r - | — LTI - ' 1

Emerging Technologies
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AOP System Development -- Agenda

 What is Aspect-Oriented Programming?
* High level system requirements.
e (Can Object-Oriented systems be improved upon?

e How do we know what has been done and/or is
happening in our system?

* Does it work? Is it extensible, maintainable,
etc.?

e \What's left?

 Wrap up — meet me for a beer (or two) at the
reception...
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System lifecycle sequence.

 Project is compiled (domain classes, aspects, binary weaving).
* Project is deployed (or (re)published).
 Tomcat startup:

e Stripes analyzes classpath for ActionBeans and maps them when found -
taking note of UrIBindings

« *domain.* classes inter-typed as AspectActionBeans.
e **Binary weaving for dynamic @UrIBinding values.
« Stripes analyzes mapped ActionBeans for “event handlers”

* **Inter-typed @DefaultHandler and @HandlesEvent methods are
mapped.

e System ready to service..
 Client makes a request
e Stripes' front controller intercepts the request...
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System lifecycle sequence (continued).

Stripes determines the request is mapped and if so, creates a new instance of
the ActionBean.

* **Binary weave steps in and determines whether the request includes an
id. If anid is present, the aspect attempts to return a hydrated object from
Db4o. Otherwise, the aspect delegates back to Stripes.

 The returned ActionBean is first bound with any request parameters.
 The ActionBean's event is then invoked.

« **If applicable, the actionBean is saved to the object database.

* **Around advice dynamically provide the Response type.

« Stripes analyzes the Response type and dispatches accordingly.

* Live Demonstration with Debugging.
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What's left?

Aspect library to dynamically:

e configure multiple types of persistence
e configure an adaptation to a completely different MVC framework

Deleting objects:
e time didn't allow for this to be fully investigated

Pretty up the Ul

e Sitemesh comes to mind
* Your imagination is the limit!
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In Summary

» After gathering requirements, take a step back
and exercise Aspectual Decomposition.

* |n order to determine where binary weaving may
need to take place, get a HelloWorld application
running and simply set breakpoints.

* |f you run into problems with the compiler,
particularly when working with annotations in
Aspectd 5, there is almost always a different way
to “skin the cat”. (But don't forget to file a bug
report!)
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Relevance/Practicality?

 This demo showed that POJOs can be adapted to
environments not necessarily envisioned at their
time of creation.

* This approach also enables a delay in

architectural decision.

 Domain may be developed while concurrent research is being
done on other architectural components.

* Once the components have been identified, it only takes a couple
aspects to adapt the model to them.

e This approach, enables easy migration from

“legacy” frameworks to “"modern”
 For example, Spring to Guice (simply inter-type new annotations).
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Any Questions?

 Please feel free to stop up and check out the
code for yourself!

 The code and presentation will be made
available.

e All code and slides were written using Open-

Source Software:

e Ubuntu Linux 6.10: ubuntu.com
* Eclipse/AJDT: eclipse.org

* OpenOffice: openoffice.org

e Stripes: stripes.mc4j.org

e Db4o: db4o.com

» |adies and Gentlemen, Thank-you!
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